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Preface
Oracle® Endeca Information Discovery Integrator is a powerful visual data integration environment that
includes:

The Information Acquisition System (IAS) for gathering content from delimited files, file systems, JDBC
databases, and Web sites.

Integrator ETL, an out-of-the-box ETL purpose-built for incorporating data from a wide array of sources,
including Oracle BI Server.

In addition, Oracle Endeca Web Acquisition Toolkit is a Web-based graphical ETL tool, sold as an add-on
module. Text Enrichment and Text Enrichment with Sentiment Analysis are also sold as add-on modules.
Connectivity to data is also available through Oracle Data Integrator (ODI).

About this guide
This guide describes how to download, install, and start the Integrator Acquisition System on Windows and
UNIX.

Who should use this guide
This guide is intended for developers who are responsible for loading source data into an Endeca data
domain.

Conventions used in this guide
The following conventions are used in this document.

Typographic conventions

The following table describes the typographic conventions used in this document.

Typographic conventions

Typeface Meaning

User Interface Elements This formatting is used for graphical user interface elements such as
pages, dialog boxes, buttons, and fields.

Code Sample This formatting is used for sample code phrases within a paragraph.

<Variable Name> This formatting is used for variable values, such as <install path>.

File Path This formatting is used for file names and paths.
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Symbol conventions

The following table describes symbol conventions used in this document.

Symbol conventions

Symbol Description Example Meaning

> The right angle bracket, File > New > Project From the File menu,
or greater-than sign, choose New, then from
indicates menu item the New submenu,
selections in a graphic choose Project.
user interface.

Contacting Oracle Customer Support
Oracle Customer Support provides registered users with important information regarding Oracle software,
implementation questions, product and solution help, as well as overall news and updates from Oracle.

You can contact Oracle Customer Support through Oracle's Support portal, My Oracle Support at
https://support.oracle.com.
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Chapter 1

Before You Install

This section provides an overview of the Integrator Acquisition System, system requirements, and other
information you need to know before installing.

Overview of the Integrator Acquisition System

Choosing to install IAS into WebLogic Server or Jetty Web server

System requirements

IAS Document Conversion Module

Supported data sources

Recommended reading

Overview of the Integrator Acquisition System
The Integrator Acquisition System, or IAS, is a set of components that crawl source data stored in a variety of
formats including: file systems, JDBC databases, flat files, Web servers, and custom data sources. IAS
transforms the data, if necessary, and outputs the data to an XML file or a Record Store that can be accessed
by Integrator ETL.

Choosing to install IAS into WebLogic Server or Jetty Web
server
IAS installs into an application server and runs as a hosted application. IAS supports both WebLogic Server
and Jetty Web server.

You typically install IAS into WebLogic Server in scenarios where your other Endeca products are also running
in WebLogic Server and in production environments. For example, you might have IAS, Integrator ETL,
Studio, and Endeca Server running as applications in WebLogic Server. Note however, IAS does not require
many features provided by WebLogic, so this installation approach is primarily for ease of administration when
hosting the entire Endeca stack.

You typically install IAS into Jetty in scenarios where you want a light-weight Web server to host IAS while you
perform data development work in a development environment.

System requirements
The Integrator Acquisition System has the following system requirements. In this guide, the term “x64” refers
to any processor compatible with the AMD64/EM64T architecture. Hard disk capacity must be sufficient to
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store the records written to the Record Store or to record output files. Please contact your Oracle
representative if you need more information on hardware sizing.

Supported operating systems

IAS is supported on the following 64-bit operating systems:

Operating System Description

Oracle Linux
• Oracle Linux Release 6 for x64

• Oracle Linux Release 5 for x64

Only the Red Hat Compatible Kernel is supported.

Linux RHEL
• Red Hat Enterprise Linux Server version 6 for x64

• Red Hat Enterprise Linux Advanced Platform version 6 for x64

• Red Hat Enterprise Linux Server version 5 for x64

• Red Hat Enterprise Linux Advanced Platform version 5 for x64

For best performance on Red Hat Linux version 5 (Server and Advanced), Oracle
recommends the latest version of RHEL 5.

Windows 2008 Windows Server 2008 R2 Enterprise.

Hardware requirements for Linux and Windows on x64

Minimum hardware requirements:

• x64 processor, minimum 1.8 GHz

• 4 GB of RAM

• At least an 500 GB hard drive, depending on the size of your application data set

Software requirements when installing IAS into WebLogic Server

IAS runs in an application server. If you are installing IAS into WebLogic Server, the following software is
required:

Software Supported Versions

Application server Oracle WebLogic Server 11gR1 (10.3.6)

Java Sun Java 6. Oracle recommends that you use the latest Java 6 update.

Software requirements when installing IAS into Jetty Web server

There are no additional software requirements if you install IAS into the Jetty Web server.
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IAS Document Conversion Module
The IAS Document Conversion Module is installed and enabled by default as part of the IAS installation. (IAS
repackages and calls Outside In® Search Export 8.4.0 to perform document conversion during a crawl.)

For a list of supported file formats, see "Appendix B File Formats Supported by the IAS Document Conversion
Module" in the Integrator Acquisition System Developer's Guide.

Supported data sources
For the full list of all supported data sources and information about configuring each, see the Integrator
Acquisition System Developer's Guide.

Recommended reading
Before installing, Oracle recommends that you read the following documents for important information about
the release.

Getting Started Guide

The Oracle Endeca Information Discovery Getting Started Guide guides you through the process of exploring
a sample Endeca Information Discovery application.

Integrator User's Guide

The Oracle Endeca Information Discovery Integrator ETL User's Guide describes how to use the Oracle
Endeca Information Discovery Integrator ETL to add data into an Endeca data domain.

Release Notes

Refer to the release notes for information about new features, changed features, and bug fixes for this
release. The release notes (README.txt) are part of the IAS documentation download. After installation,
release notes are also available in the following location:

• Windows: <install path>\Oracle\Endeca\IAS\<version>

• UNIX: <install path>/Oracle/Endeca/IAS/<version>
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Chapter 2

Installing the Integrator Acquisition System

This section describes how to install IAS into either Jetty or into WebLogic Server and then describes the
contents of the installation directory.

Downloading IAS

About installing IAS on WebLogic Server

Installing on Windows

Installing on UNIX

Web Crawler installation

Package contents and directory structure

Downloading IAS
You download IAS from the Oracle Software Delivery Cloud.

To download IAS:

1. Sign in to https://edelivery.oracle.com.

2. Accept the terms and restrictions.

3. On the Media Pack Search page:

(a) From the Select a Product Pack drop-down list, select Oracle Endeca.

(b) From the Platform drop-down list, select the platform you are installing on.

(c) Click Go.

4. In the media pack list, click Oracle Endeca Information Discovery Integrator (3.1) Media Pack for
<platform>.

5. Download Integrator Acquisition System (3.1) for <platform>.

About installing IAS on WebLogic Server
You can install IAS as an application running in Oracle WebLogic Server. In most installation scenarios, you
install IAS on the same WebLogic Server instance as Studio and Endeca Server. (You can skip this section if
you plan to install IAS into Jetty.)

Before installing IAS into WebLogic Server, you must perform the following installation tasks:

1. Downloading and installing the Sun JDK.

2. Downloading and installing WebLogic Server.
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You install IAS into WebLogic Server by running the IAS installation script and selecting WebLogic Server as
the installation target. The IAS installation script creates and configures a WebLogic domain and then deploys
IAS into that domain. By default, the new IAS domain is created in production mode rather than development
mode.

For full instructions on installing all of Oracle Endeca Information Discovery (Endeca Server, Integrator ETL,
Studio, and Provisioning Service) on a single WebLogic Server in a Windows environment, see the Oracle
Endeca Information Discovery Getting Started Guide.

Downloading and installing the Sun JDK

Downloading and installing WebLogic Server

Downloading and installing the Sun JDK

Before installing WebLogic Server, you must install the Sun JDK.

To download and install the Sun JDK:

1. To download Sun Java 6:

(a) Go to http://www.oracle.com/technetwork/java/javase/downloads/index.html.

(b) On the Downloads tab, click Previous Releases.

(c) On the Oracle Java Archive page, click Java SE 6.

(d) On the Java SE 6 Downloads page, click the link for the most recent version of the Java SE
Development Kit.

The page scrolls to the list of downloads for that version of the JDK.

(e) At the top of the list, click the Accept License Agreement radio button.

(f) In the list, click the Download link for Windows x64 or Linux x64.
(g) Save the file (jdk-<version>-windows-x64.exe or jdk-<version>-linux-x64.bin) to

your machine.

2. To install the JDK on Windows:

(a) Double-click the JDK installer file.

The welcome page of the installation wizard displays.

Oracle® Endeca Information Discovery Integrator: Integrator Version 3.1.0 Rev. A • December 2013
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Installing the Integrator Acquisition System 11

(b) On the welcome page, click Next.
(c) Because the default installation location (under Program Files) has a space, you must change

it. On the Custom Setup page, click Change.

(d) In the Folder name field, remove the Program Files directory, to change the location to:
C:\Java\jdk1.6.0_43\

(e) Click OK.

Oracle® Endeca Information Discovery Integrator: Integrator Version 3.1.0 Rev. A • December 2013
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(f) On the Custom Setup page, verify that the installation location has updated, then click Next.

(g) On Destination Folder page, leave the default directory and click Next.

The installation process begins.

(h) When the installation completes, click Finish.

3. To install the Sun JDK on Linux:
(a) Select a location for installation. For example, $HOME/Oracle/Endeca.

(b) Place the JDK .bin file (for example, jdk-6u43-linux-x64.bin) into $HOME/Oracle/Endeca,
and ensure that it has execute permissions,

(c) Execute the file.

The JDK is extracted into the directory. For example, $HOME/Oracle/Endeca/jdk1.6.0_43.

Oracle® Endeca Information Discovery Integrator: Integrator Version 3.1.0 Rev. A • December 2013
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Downloading and installing WebLogic Server

If you are not installing IAS on the same server as Endeca Server, then you need to download and install
WebLogic Server.

To download and install WebLogic Server:

1. To download the WebLogic Server installation package:

(a) Go to http://www.oracle.com/technetwork/middleware/weblogic/downloads/wls-for-dev-
1703574.html.

(b) Under Oracle WebLogic Server Previous Releases, expand the list for Oracle WebLogic Server
10.3.6.

(c) Download the Generic version of the installer (wls1036_generic.jar).

2. From a command prompt, navigate to the directory where you placed wls1036_generic.jar.

3. To launch the installer, issue the following command:

java -jar wls1036_generic.jar

Acquisition System Installation Guide

The Welcome page of the installation wizard is displayed.

4. On the Welcome page, click Next.

5. On the Choose Middleware Home Directory page:

(a) Click the Create a new Middleware Home radio button.
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(b) Accept the default location for the Middleware Home Directory.

(c) Click Next.

6. To bypass the Register for Security Updates page:

(a) Click Next without entering an email address.

(b) On the Email Address Not Specified dialog, click Yes.

(c) On the Are You Sure? dialog, click Yes.

(d) On the Connection failed dialog, check the I wish to remain uninformed of security issues in
my configuration or the machine has no Internet access checkbox, then click Continue.
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7. On the Choose Install Type page, click the Custom, then click Next.

8. On the Choose Products and Components page, check the following products, then click Next:

• Core Application Server

• Administration Console

• Configuration Wizard and Upgrade Framework

• Evaluation Database

9. On the JDK Selection page, verify that the JDK you installed is selected. If it is, click Next. If that
version of the JDK is not selected:

(a) Under Local JDK, click Browse.
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(b) Browse to and select the directory that contains the JDK. For example, C:\Java\jdk1.6.0_43\
or $HOME/Oracle/Endeca/jdk1.6.0_43)

The Local JDK section updates to display the selected JDK with a checked box next to it.

(c) Click Next.

10. On the Choose Product Installation Directories page, accept the default installation directory, then
click Next.
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11. If the Install Windows Service page displays, click the No, then click Next.

12. If the Choose Shortcut Location page displays, click a radio button to select the location of the
Windows shortcut, then click Next.
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13. On the Installation Summary page, verify that you are installing the correct products, then click Next.

14. On the Installation Complete page, uncheck Run Quickstart, then click Done.

For Windows, an Oracle WebLogic shortcut is created in the Start Menu.

Installing on Windows
This section describes how to install the Integrator Acquisition System on Windows.

Creating a user for the Endeca services on Windows

Installing IAS on Windows

Installing IAS silently on Windows

Oracle® Endeca Information Discovery Integrator: Integrator Version 3.1.0 Rev. A • December 2013
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Creating a user for the Endeca services on Windows

This topic applies only to IAS installations on Jetty Web server. You can skip this topic if you install IAS on
WebLogic Server. You must run the Endeca services as a specified user, for which you can control
permissions.

The IAS installation script prompts for the Endeca services user during the installation process. Oracle
recommends that you create a user account called endeca that has the file and directory permissions to
access all necessary files for your application. However, you can use any user that you prefer, as long as it
meets these requirements.

To create the user endeca:

1. Ensure that you have administrator privileges on the local machine.

2. From the Windows Control Panel, select Computer Management>Administrative Tools.

3. In the tree pane of the Computer Management window, select System Tools>Local Users and
Groups.

4. Right-click Users and select New User.

5. In the New User dialog box, do the following:
(a) Enter endeca for both the User name and the Full name.

(b) Optionally, enter a description.
(c) Set a password for user endeca.

Note: The user must have a non-blank password, because the installer will not accept a
blank password for the services user.

(d) Uncheck User must change password at next logon.

6. Click Create to create the new user, and then Close to exit the dialog box.

7. Close the Computer Management window, but do not exit Administrative Tools.

8. From Administrative Tools, do the following:

(a) Open Local Security Policy.

(b) In the Local Security Settings window, select Local Policies>User Rights Assignments.

(c) From the list of policies on the right, open Log on as a Service.
(d) Add user endeca to the list of users that can register a process as a service.

(e) Close the dialog box and exit Administrative Tools.

Installing IAS on Windows

The installation process is made up of two steps: extracting a ZIP to put the IAS files on disk and then running
an IAS installation script to deploy IAS. The script prompts you to select a server type to host IAS. If you
select Jetty Web server, the script then gathers environment and user information and then creates and starts
the Endeca IAS Service. If you select WebLogic Server, the script creates, deploys, and starts an IAS
application running in WebLogic Server.

Before installing, ensure that you have met the following pre-requisites:

• If you are installing on Jetty, ensure you have administrator privileges on the local machine.

Oracle® Endeca Information Discovery Integrator: Integrator Version 3.1.0 Rev. A • December 2013
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To install IAS on Windows:

1. In your local environment, locate the Endeca IAS software that you downloaded from the Oracle
Software Delivery Cloud.

2. Extract the ZIP file to C:\.

This creates the IAS files on disk at C:\Oracle\Endeca\IAS.

3. Open a command prompt window and change to C:\Oracle\Endeca\IAS\<version>\bin.

4. Run the ias-setup.bat script.

5. Select a server type to host the IAS installation:
• Type 1 to install IAS into WebLogic Server and press Enter.

• Type 2 to install IAS into Jetty Web server and press Enter.

6. If you selected 1 for WebLogic Server:

(a) Specify the WebLogic home location or accept the default home location of
C:\Oracle\Middleware\wlserver_10.3 by pressing Enter.

(b) Specify a WebLogic domain name for IAS. Oracle recommends specifying ias.

(c) Specify a username for the domain.

(d) Specify a password for the domain and confirm the password.

(e) Specify a port for the WebLogic domain or accept the default of 8401 by pressing Enter.

(f) Specify the fully qualified hostname that runs IAS or accept the default by pressing Enter.

The IAS installation script creates the WebLogic domain with the username and password you
specified, deploys IAS as an application into the domain, and then restarts the domain.

7. If you selected 2 for Jetty:

(a) Specify a domain and username to run the Endeca IAS Service and press Enter.

This is typically the endeca that you created previously, but can be any user that has the file and
directory permissions to access all necessary files for your application.

(b) Specify the password for the user.

(c) Confirm the password for the user.

(d) Specify a port for the Endeca IAS Service, or accept the default of 8401 by pressing Enter

(e) Specify a shutdown port for the Endeca IAS Service, or accept the default of 8403 by pressing
Enter.

(f) Specify the fully qualified hostname that runs IAS, or accept the default by pressing Enter.

The Endeca IAS Service is registered and started.

You can confirm that IAS is running by starting a Web browser and loading the IAS Server WSDL.

If you installed IAS into Jetty Web Server, open http://<hostname>:8401/ias/?wsdl, or if you installed
into WebLogic Server, open http://<hostname>:8401/ias-server/ias/?wsdl.

The following WSDL displays:

<?xml version="1.0" encoding="UTF-8" ?>
- <wsdl:definitions name="IasCrawlerService" targetNamespace="http://endeca.com/eidi/ias
/2011-12" xmlns:ns1="http://schemas.xmlsoap.org/soap/http" xmlns:soap="http://schemas.xmlsoap.org
/wsdl/soap/" xmlns:tns="http://endeca.com/eidi/ias/2011-12" xmlns:wsdl="http://schemas.xmlsoap.org
/wsdl/" xmlns:xsd="http://www.w3.org/2001/XMLSchema">

- <wsdl:types>

Acquisition System Installation Guide
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Installing IAS silently on Windows

IAS provides a silent installation mode that is useful if you want to add the IAS installation to a general Endeca
installation script, or install IAS on multiple machines using a scripted approach.

The silent installer is not interactive. You run the installation script and provide a text file as input. The text file
contains response values to the installation prompts that would normally be answered by a user.

The file must contain a single row that specifies a response value for each IAS installation prompt. The
response values vary depending on whether you are installing IAS into WebLogic Server or Jetty.

The order of prompts to install IAS into WebLogic Server is the following:

Installation mode
Weblogic home
IAS domain name
IAS domain user
IAS domain password
IAS domain port
IAS host

For example, here are the contents of a text file with response values that correspond to the WebLogic Server
prompts:

1
C:\Oracle\Middleware\wlserver_10.3
ias
weblogic
weblogic123
8401
mymachinename.companydomain.com

The order of prompts to install IAS into Jetty is the following:

Installation mode
Endeca IAS Service username
Endeca IAS Service user password
IAS port
IAS shutdown port
IAS host name

For example, here are the contents of a text file with response values that correspond to the Jetty prompts:

2
TEST\endeca
Password01
8401
8403
mymachinename.companydomain.com

To Install IAS silently on Windows machines:

1. Start a text editor and create a .txt file with response values as described above.

2. Save the .txt file to <install path>\IAS\<version>\bin.

For example, save the file as silent.txt.

3. Open a command prompt and change to the location of the installation script at <install
path>\IAS\<version>\bin.
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4. Run the ias-setup.bat with the --silent flag, any optional arguments, and also specify the
response file as an input.

For example:

ias-setup.bat --silent < silent.txt

Acquisition System Installation Guide

Following installation, the WebLogic domain for IAS is restarted, and on Jetty, the Endeca IAS Service starts
automatically.

Installing on UNIX
This section describes how to install the Integrator Acquisition System on UNIX.

Installing IAS on UNIX

Adding the Endeca IAS Service to inittab on UNIX

Installing IAS silently on UNIX

Installing IAS on UNIX

The IAS software is distributed as a ZIP file that contains an installation script for UNIX platforms. You extract
the ZIP file and run the script to install IAS. IAS can be installed to any location, but this procedure assumes
IAS will be installed into /usr/local. IAS unpacks to approximately 400 MB. Because multiple versions may
be installed, a destination in a large partition is recommended. Differences between WebLogic Server and
Jetty installations are called out in each step.

To install IAS on UNIX:

1. Locate the installation file that you downloaded from the Oracle Software Delivery Cloud.

2. Extract the ZIP file to a temporary directory.

The ZIP file contains an installation script named EID_<version>_IAS.sh.

3. Open a command prompt, change to the temporary directory, and run the installation script with the
following command:

./EID_310_IAS.sh --target /usr/local

The script prompts you for a number of configuration options.

4. Select a server type to host the IAS installation:
• Type 1 to install IAS into WebLogic Server and press Enter.

• Type 2 to install IAS into Jetty Web server and servlet container and press Enter.

5. If you selected 1 for WebLogic Server:

(a) Specify the WebLogic home location.

For example, this is typically /usr/local/Oracle/Middleware/wlserver_10.3.

(b) Specify a WebLogic domain name for IAS. Oracle recommends specifying ias.

(c) Specify a username for the domain name.

(d) Specify a password for the domain name.

(e) Specify a port for the WebLogic domain, or accept the default of 8401 by pressing Enter.
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(f) Specify the fully qualified hostname that runs IAS, or accept the default by pressing Enter.

The IAS installation script creates the WebLogic domain with the username and password you
specified, deploys IAS as an application into the domain, and then restarts the domain.

6. If you selected 2 for Jetty:

(a) Specify a port for the Endeca IAS Service, or accept the default of 8401 by pressing Enter

(b) Specify a shutdown port for the Endeca IAS Service, or accept the default of 8403 by pressing
Enter.

(c) Specify the fully qualified hostname that runs IAS, or accept the default by pressing Enter.

To start the Endeca IAS Service after installation, navigate to
/usr/local/Oracle/Endeca/IAS/<version>/bin and run ias-service.sh.

You can confirm that IAS is running by starting a Web browser and loading the IAS Server WSDL.

If you installed IAS into Jetty Web Server, open http://<hostname>:8401/ias/?wsdl, or if you installed
into WebLogic Server, open http://<hostname>:8401/ias-server/ias/?wsdl.

The following WSDL displays:

<?xml version="1.0" encoding="UTF-8" ?>
- <wsdl:definitions name="IasCrawlerService" targetNamespace="http://endeca.com/eidi/ias
/2011-12" xmlns:ns1="http://schemas.xmlsoap.org/soap/http" xmlns:soap="http://schemas.xmlsoap.org
/wsdl/soap/" xmlns:tns="http://endeca.com/eidi/ias/2011-12" xmlns:wsdl="http://schemas.xmlsoap.org
/wsdl/" xmlns:xsd="http://www.w3.org/2001/XMLSchema">
- <wsdl:types>
...
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Adding the Endeca IAS Service to inittab on UNIX

This topic applies only to IAS installations on Jetty Web server. You can skip this topic if you install IAS on
WebLogic Server. In a UNIX development environment, the Endeca IAS Service can be started from the
command line. In a UNIX production environment, however, Oracle recommends starting it from inittab.

In UNIX you run the IAS Server using ias-service.sh, located in
usr/local/Oracle/Endeca/IAS/<version>/bin. You can write a script that calls ias-service.sh
and is referenced in inittab.

When writing your script, Oracle recommends that you run the Endeca IAS Service as a user other than root.

This sample script (named start_ias_service.sh) sets the ENDECA_USER variable to the “endeca” user
and then issues an su command to change to the “endeca” user:

#!/bin/sh
ENDECA_USER=endeca
IAS_ROOT=/usr/local/Oracle/Endeca/IAS/3.1.0
IAS_WORKSPACE=/usr/local/Oracle/Endeca/IAS/workspace

# change to user endeca
su $ENDECA_USER -c "cd $IAS_ROOT/bin; \

$IAS_ROOT/bin/ias-service.sh >> $IAS_WORKSPACE/logs/ias-service-wrapper.log 2>&1"

The start_ias_service.sh script is then referenced in inittab with an entry similar to this example:

eias:2345:respawn:/usr/local/Oracle/Endeca/IAS/3.1.0/bin/start_ias_service.sh

When writing your startup script, keep in mind that it is server-specific, and therefore its details (such as paths
and user names) depend on the configuration of your server.
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Installing IAS silently on UNIX

IAS provides a silent installation mode that is useful if you want to add the IAS installation to a general Endeca
installation script, or install IAS on multiple machines using a scripted approach.

The silent installer is not interactive. You run the installation script and provide a text file as input. The text file
contains response values to the installation prompts that would normally be answered by a user.

The file must contain a single row that specifies a response value for each IAS installation prompt. The
response values vary depending on whether you are installing IAS into WebLogic Server or Jetty.

The order of prompts to install IAS into WebLogic Server is the following:

Installation mode
Weblogic home
IAS domain name
IAS domain user
IAS domain password
IAS domain port
IAS host
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For example, here are the contents of a text file with response values that correspond to the WebLogic Server
prompts:

1
/usr/local/Oracle/Middleware/wlserver_10.3
ias
weblogic
weblogic123
8401
mymachinename.companydomain.com

The order of prompts to install IAS into Jetty is the following:

Installation mode
IAS port
IAS shutdown port
IAS host name

For example, here are the contents of a text file with response values that correspond to the Jetty prompts:

2
8401
8403
mymachinename.companydomain.com

To install IAS silently on UNIX machines:

1. Start a text editor and create a .txt file with response values as described above.

2. Save the .txt file to <install path>/IAS/<version>/bin.

For example, save the file as silent.txt.

3. Open a command prompt and change to the location of the installation script at <install
path>/IAS/<version>/bin.

4. Run the install script with the --silent flag, the --target flag (which specifies the absolute path of
the target installation directory), any optional arguments, and the response file as an input.

For example:

./EID_3.1.0_IAS.sh --silent --target /usr/local < silent.txt
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After installation, the WebLogic domain for IAS is restarted automatically. In Jetty installations, you start IAS
by changing to /usr/local/Oracle/Endeca/IAS/<version>/bin and running ias-service.sh.

Web Crawler installation
The Endeca Web Crawler is installed as part of IAS.

The Web Crawler startup script is in IAS\<version>\bin (and in the equivalent path on UNIX). The Web
Crawler configuration files are in IAS\workspace\conf\web-crawler (and in the equivalent path on
UNIX). See the Integrator Acquisition System Web Crawler Guide for details and usage.

Package contents and directory structure
The IAS directory is the root directory for the Integrator Acquisition System.

After installing the Integrator Acquisition System, you see this directory structure:

IAS
3.1.0

bin
...

workspace
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The contents of the IAS directory are described here in detail.

Directory Contents

<version>\bin
• Scripts to start the IAS Service on Jetty (ias-
service.sh and ias-service.bat).

• Scripts to shut down the IAS Service on Jetty (ias-
service-shutdown.sh and ias-service-
shutdown.bat).

• Scripts to run the IAS Server Command-line Utility
(ias-cmd.sh and ias-cmd.bat).

• Scripts to run the Component Instance Manager
Command-line Utility (component-manager-cmd.sh
and component-manager-cmd.bat).

• Scripts to run the Record Store Command-line Utility
(recordstore-cmd.sh and recordstore-
cmd.bat).

• Scripts to run the Web Crawler (web-crawler.sh for
and web-crawler.bat).

• Executable to run the IAS Service as a Windows
service on Jetty (ias-service-wrapper.exe).
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Directory Contents

<version>\doc The reference documentation (Javadoc) for the IAS Server,
the Component Instance Manager, the Record Store, the
IAS Extension API, and the Web Crawler.

<version>\doc\wsdl The Web Service (WSDL) files for the IAS Server, the
Component Instance Manager, and the Record Store.

<version>\java The JDK used to run the IAS components.

<version>\lib
• Libraries for the IAS command-line utilities including:

the IAS Server utility, the Component Instance Manager
utility, the Record Store utility.

• Libraries for the IAS APIs including: the IAS Server API,
the Component Instance Manager API, the Record
Store API, and the IAS Extension API.

<version>\lib\ias-server-plugins Libraries for IAS plugins and custom extensions (if
applicable).

<version>\lib\oit-sx The IAS Document Conversion Module libraries.

<version>\lib\web-crawler The Web Crawler libraries.

<version>\sample Directories for the sample applications and sample
extensions. The sample applications are documented in the
IAS Developer's Guide and also in the IAS Extension API
Guide.

<version>\webapps\jetty The root.war file, which is the IAS Server and
Component Instance Manager as a standalone application.

<version>\webapps\weblogic
• The ias.war file, which is the IAS Server and

Component Instance Manager as a WebLogic
application.

• The Plan.xml file, which is the WebLogic deployment
plan for security configuration.

<version>\workspace_template The template for the workspace directory that contains
configuration files.

workspace The working directory for the IAS Server and the Web
Crawler.
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Directory Contents

workspace\conf
• The commandline.properties file, which contains

the IAS Service settings necessary for the IAS
command-line utilities to run.

• Three logging configuration files (ias-
service.log4j.properties
for the IAS Service, recordstore-
cmd.log4j.properties for the Record Store, and
ias-cmd.log4j.properties for the Command-line
Utility).

• The Jetty configuration files.

workspace\conf\web-crawler\default The default configuration files for the Web Crawler,
including the log4j.properties logging configuration
file.

workspace\conf\web-crawler\non- Sample crawl configuration files for non-polite crawls. As
polite-crawl with the polite version, the settings in these files will

override the default settings.

workspace\conf\web-crawler\polite- Sample crawl configuration files for polite crawls. The
crawl settings in site.xml will override the same property

settings in the default.xml file, while the crawl-
urlfilter.txt file will also override the default version
of the file.

workspace\logs The ias-service.log file, which contains the IAS
Service log output, and includes log messages from all
crawls managed by the IAS Server.

workspace\output Default destination directory for the crawl output from the
Web Crawler. The output directory is not present upon
installation. It is created when the Web Crawler writes to
output records for a crawl.

workspace\state State files for the IAS Service components. State files can
include Record Store instances, state directories for data
source extension information, and state directories for
manipulator extension information.

Note: There is no logs directory for the Web Crawler, because by default the Web Crawler sends its
standard output to the console. However, you can modify the log4j.properties file to send the
output to a file.
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Chapter 3

Uninstalling the Integrator Acquisition
System

This section describes how to uninstall the Integrator Acquisition System.

Uninstalling IAS on Windows

Uninstalling IAS on UNIX

Uninstalling IAS on Windows
To uninstall on Windows, you first back up the workspace directory, then follow the appropriate uninstall
process.

Before uninstalling, ensure that you have met the following prerequisites:

• If you are uninstalling on Jetty, ensure you have administrator privileges on the local machine.

To uninstall IAS from a Windows machine:

1. From Windows Explorer, copy the <install path>\IAS\workspace directory to a backup location
that is outside the IAS installation directory.

(You might use this content later in migration scenarios.)

2. For IAS installations on Jetty Web server:

(a) From Windows Services console, stop the Endeca IAS Service.
(b) Open a command prompt window and change to <install path>\IAS\<version>\bin.

(c) Run uninstall-ias-service.bat to remove the Endeca IAS Service.

If you leave the Windows Services console open after removing the Endeca IAS Service, it does not
update to show that the service has been removed until you close and re-open it.

3. For IAS installations on WebLogic Server:

(a) Stop the IAS application from either the Weblogic Administration Console or by navigating to
<IAS domain path>\bin and running stopWeblogic

(b) Remove the WebLogic domain for the IAS application. For details, see the WebLogic
documentation.

4. From Windows Explorer, navigate to the Endeca installation directory and delete the IAS directory.

For example, this is typically located at C:\Oracle\Endeca.
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Uninstalling IAS on UNIX
The Integrator Acquisition System must be manually uninstalled.

To uninstall IAS from a UNIX machine:

1. Stop IAS.
• For IAS installations on Jetty Web server: open a command prompt, navigate to <install

path>/IAS/<version>/bin, and run ias-service-shutdown.sh.

• For IAS installations on WebLogic Server: stop the WebLogic Server using either the Weblogic
Administration Console or by navigating to <domain path>/bin and running
stopWeblogic.sh.

2. Copy the <install path>/IAS/workspace directory to a backup location that is outside the IAS
installation directory.

(You might use this content later in migration scenarios.)

3. In a command prompt, issue an rm command as in this example:
rm -rf Oracle/Endeca/IAS

4. For IAS installations on WebLogic Server, remove the WebLogic domain for the IAS application. For
details, see the WebLogic documentation.
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